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Abstract
Autonomous Unmanned Ground Vehicle for Non-Destructive Testing of Fiber
Reinforced Polymer Bridge Decks
Anthony Scott Mercer
The objective of this research is to develop an Unmanned Ground Vehicle (UGV) that
can autonomously gather data for analysis of FRP bridge decks. Both ground penetrating radar
(GPR) and infrared thermography (IRT) have shown promise in the field of non-destructive
detection of defects in FRP decks. Even though both technologies can be effective, they each
have certain limitations. For example, GPR is sensitive to water-filled defects while IRT is more
sensitive to air-filled defects. This thesis investigates the effectiveness of combining and
automating the data acquisition for each technique. Since both IRT and GPR analysis are
subjective in nature, automating the data collection, including the heating preparation required
with IRT analysis, involved with surveying an FRP deck may allow for a more objective analysis
of the FRP deck. The reliability of the autonomous data acquisition of the UGV was assessed, as
well as the effectiveness of combining IRT and GPR. Experimentation with various heat sources
showed that passive heating should not be used for autonomous data acquisition. Testing
showed that active heating with a strong heat source produced good quality IR images a
reasonable amount of time. Analysis of these IR images with various image processing
techniques, such as fuzzy c-means clustering, automatic defect detection schemes with
approximately 87.5% detection rates could be implemented. An Unmanned Ground Vehicle
(UGV) was created that combined an active heating system, an IR camera, and GPR analysis. A
pipelining process was implemented that allows the UGV to perform the autonomous data
acquisition as efficiently as possible. The UGV was then used to evaluate the effectiveness of
combining IRT and GPR. Due to laboratory limitations, no actual testing was done that
incorporates both analysis methods simultaneously. However, results show that the data
collected can be used to determine both air and water filled defects and will provide valuable
data when combined.
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Chapter 1

Introduction
1.1 Background
Roadway infrastructure deterioration within the United States is a serious concern of civil
engineers in this country. According to the Federal Highway Administration (FHWA)
approximately 27% of the 594,220 bridges in the United States are either structurally deficient or
functionally obsolete [1]. Even with billions of dollars devoted to the repair or replacement of
these structures, the current design practices and technologies used by America’s civil engineers
may not be enough to overcome the deterioration of our infrastructure. The answer to this
problem may lie in the research of new technologies. To this end, scientists and engineers have
begun to experiment with new materials for civil infrastructure construction and repair.

Fiber Reinforced Polymer (FRP) composite is one such material that is gaining
prominence in civil engineering infrastructure systems. FRP composites, as the name indicates
are composites of different materials. Glass or carbon fibers are used for stiffness and tensile
capacity. Resin is added to solidify the fibers into a strong matrix for high compressive strength.
Various other additives are added to improve the polymer’s mechanical and physical properties.
Detailed information about the manufacture of FRP and its useful properties has been previously
studied and published [2]. Because of its properties, such as high strength, a high stiffness to
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weight ratio, resistance to fatigue, exceptional durability, and high resistance to environmental
conditions, FRP bridge decks are being considered for replacing old concrete bridge decks.

With the introduction of new technology comes the need for ways of assessing and
analyzing those technologies. Effective condition monitoring techniques for FRP materials need
to be developed in order to detect subsurface cracks, determine the onset of structural failure,
estimate any structural degradation, and locate any structural damages. Such techniques are
necessary to evaluate the quality and integrity of a structure in the field. FRP bridge decks are
susceptible to debonds, a subsurface defect that is present at the interface between the wearing
surface layer and the underlying FRP deck, and delaminations, a defect present within the top or
bottom flange of the FRP deck. These defects can lower the load carrying capacity and decrease
structural integrity. Hence it is necessary to develop techniques that can effectively monitor the
FRP deck for defective areas.

1.2 Research Objective
This research aims at building a UGV to autonomously analyze an FRP deck. To
accomplish this objective, the following steps have been taken:

•

Conduct a literature review on the advantages and disadvantages of IRT and GPR in regards
to analysis of FRP bridge decks.

•

Combine IRT and GPR analysis to create a robust subsurface defect detection system.

•

Design and build a UGV to provide autonomous data acquisition for FRP decks analysis.

•

Provide recommendations for future research to improve the autonomous data collection and
defect analysis.

1.3 Scope
The aim of this research was to investigate the effectiveness of combining IRT and GPR
in the hopes of creating a robust subsurface defect detection system for use with FRP decks. IRT
data analysis through automated image processing algorithms designed to improve defect
2

detection is also explored. An active heating element to be used in conjunction with the IRT
analysis performed by the UGV was also researched. The scope of this research also includes
methods for shortening the data acquisition time for the IRT analysis.

1.4 Organization
This thesis is organized into six chapters. The first chapter gives a brief introduction to
the objective and scope of this research. The second chapter contains a literature survey on the
effectiveness of infrared thermography and ground penetrating radar when used as separate
defect detection methods. In the third chapter, the design of the active heating element used by
the UGV is described. In the fourth chapter, the data acquisition method of the UGV, the control
algorithms, and the physical implementation are explained. The experimental setup for testing
the UGV and the results are described in the fifth chapter. Next, the sixth chapter expresses the
conclusions drawn form the research and presents some suggestions for future work. Lastly, the
appendices provide a user’s manual describing how to set up the data acquisition of the UGV,
how to operate the UGV, and how to get the data from the UGV after testing.
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Chapter 2

Literature Review
2.1 Introduction of Infrared Thermography
Infrared thermography (IRT) is a non-destructive testing technique that uses thermal
images to detect voids, cracks, and delaminations in decks and pavements [8]. The thermal
images, which are commonly called thermograms, use shading, intensity, or color to represent
different surface temperature levels. Figure 2-1 shows a thermogram of an FRP deck that has
been heated and allowed to cool.
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Figure 2-1 Thermogram of an FRP deck

The principle behind IRT is that subsurface defects will affect the rate of heat flow
through a deck, which will result in temperature differences on the surface of the deck. The
bright yellow spots in the image are artificial air filled defects. The air acts as an insulator
allowing less heat to pass through the material. This causes the material above the defective area
to heat to a higher temperature than the surrounding area, thus allowing a tester to identify a
defect in the deck.

Some of the advantages of IRT in regards to civil engineering applications are:

1. IRT is a non-contact evaluation method so no damage to existing civil engineering structures
will result from analysis.
2. Since the data generated by IRT analysis is a thermal image it is easier to interpret when
compared to other methods like GPR or ultrasound.
3. An infrared image can cover large area so the time required for testing a structure can be
reduced.
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4. IRT only measures thermal radiation emitted from a surface. As a result no radiation is
generated by the test equipment that could be harmful to the person conducting the analysis.
5. IRT is able to detect air filled defects very well.
6. The entire process of capturing and analyzing the thermal images can be automated.

While there are quite a few advantages, IRT also has some downsides. Some of the
disadvantages of IRT are:

1. The cost of thermal imaging equipment can be fairly high. While there are more affordable
IR cameras around in today’s market, someone wanting to perform IRT could expect to pay
$15,000 to $75,000 or more for a reliable IR camera.
2. Since IRT only measures surface temperature, the accuracy of defect detection will decrease
if the depth of the defect increases.
3. Abrupt changes in temperature, such as high winds, could affect the surface temperature
therefore affecting the quality of defect detection.
4. Smaller defects cannot be detected as readily as larger defects. The reason for this is smaller
defects does not affect the thermal conductivity of the area as much as larger defects because
of their decreased surface area.
5. Water filled defects are hard to detect. This can present problems because some defects are
caused by water getting trapped in or between materials.
6. This testing requires some type of heat source. Passive heating, such as heating from the sun,
may be used, but may not be reliable due to factors such as differences in heating throughout
the day. This creates a disadvantage because for reliable results the weather must
accommodate the surveyor or the surveyor must provide some type of active heating with a
heater.

Even though IRT analysis has many useful characteristics for civil engineering
application, it is limited by its dependence on a heat source. Most IRT applications rely on solar
heating to prepare a surface for IR imaging. The data collection therefore is dependent on
location, weather, and season, among other factors. Active heating, which is heating with
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heaters, has been proposed as an alternative to of solar radiation by Infrasense Inc [25]. This
research used vehicles with mounted pavement heaters to prepare a bridge deck surface for IR
imaging. Results obtained from this research show that short durations of intense constant
heating provide infrared analysis that is comparable to longer durations of solar heating.

Research conducted by the Constructed Facilities Center (CFC) at West Virginia
University (WVU) has shown that IRT can be used to defects in FRP decks [12]. THE CFC
researchers used both active and passive heating to evaluate the quality of IRT analysis on FRP
decks. The results from this research show that IRT can be used to accurately detect subsurface
defects in FRP decks.

Infrared Thermography has also been used in other FRP health monitoring research. The
CFC subjected FRP deck specimens with plan dimensions of 24” x 12” to accelerated aging and
used IRT to monitor the decks [11]. Simulated defects were embedded in the decks during
construction. The specimens were placed in pH3 solutions (acidic) and then subjected to freezethaw cycles in an environmental chamber. Infrared Thermography was used to observe the
growth of the existing defects and the formation of new defects. The CFC also used IRT to
observe the effects of fatigue loading on FRP decks with embedded defects [10].

Like all digital images, the infrared images that are generated from IRT analysis can be
subjected to automated image processing algorithms. There has been some success in
automating defect detection in IR images. A study by Gajanan Lonkar at West Virginia
University involved creating a MATLAB based defect detection system for IR images [21].

2.2 Introduction to Ground Penetrating Radar
Ground penetrating radar (GPR) was first used by the U. S. Army for detecting mines
during the Vietnam War [14]. GPR is a non-contact technique that uses an antenna to transmit
electromagnetic energy into a surface [8]. The energy that is transmitted is reflected back by
interfaces between materials with different dielectric properties. This reflected energy is then
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collected by the antenna, converted to voltage levels, and combined to form a waveform. Figure
2-2 shows a GPR waveform.

Delay
Time (ns)

Scan Distance

Figure 2-2 GPR waveform

The different dielectric properties of the materials are the reason that GPR works. For
example, the circled area on the left of the image represents aluminum tape placed on top of an
FRP deck. Since aluminum reflects virtually all electromagnetic radiation, the interface between
the air and the aluminum tape, which have very different dielectric properties, shows up as a
bright spot near the top of the waveform. The other circled areas represent water filled debonds
between a wearing surface layer and an FRP deck. They are lower in waveform because they are
underneath another layer of material. The dielectric properties of FRP and water are different
enough to allow some electromagnetic waves to reflect off the interface of the two materials. In
this way, GPR is able to detect subsurface defects and other object such as steel drums, rebars,
etc.

8

Some of the advantages of GPR in regards to civil engineering applications are:
1. Very fast data acquisition.
2. The GPR unit is completely self-contained. This means that the system is fully mobile and
can be deployed with minimal preparation.
3. GPR analysis requires no pre-test preparation, such as heating. This decreases the overall
analysis time.
4. GPR is able to detect water filled defects very well.
5. GPR testing can be performed in any type of weather.
6. Defect depth can be determined with GPR.

While there are quite a few advantages, GPR also has some downsides. Some of the
disadvantages of GPR are:

1. The cost of thermal imaging equipment can be fairly high.
2. Air filled defects are hard to detect. This is because that the dielectric properties of air are
similar to FRP.
3. The data is harder to interpret than other methods.

GPR is used in a variety of applications. Defect detection in civil structures is not the
only application of this technology. The FBI uses GPR in forensic applications to detect
subsurface objects, such as buried bodies [19].

Even though the applications of GPR are varied, the data processing techniques remain
the same. Since the GPR survey equipment produces a visual representation of the reflected
radar waves, most of the actual analysis is done visually. This creates a very subjective data
analysis. It is possible to eliminate this subjectivity of the analysis by introducing some signal
processing algorithms. Signal processing algorithms have been applied to GPR data to improve
the GPR capabilities in terms of damage localization, identification and diagnosis of the causes
[17].
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2.3 Combining IRT and GPR
While IRT and GPR are generally employed separately, based on the experience of the
person performing the tests, it may be beneficial to use both methods during testing. The
advantages of one method can used to leverage the disadvantages of the other technology. For
example, since one of the major disadvantages of IRT is the fact that it requires a temperature
difference to detect structural defects, a heat source of some kind must be used. For situations
where passive heating can be used, like on a hot sunny day, this is not a major issue. However,
such sunny days are not always available. On the other hand, GPR is not limited by temperature
and can be used even on cold days. Also, since GPR has been found to be sensitive to waterfilled defects and IRT is more sensitive to air-filled defects, a combined system would be able to
detect both types of defects. Finally, since IRT can only be used to detect defective areas near the
surface of a deck or structure, the GPR can compensate for this weakness because it has the
ability to penetrate deeper into the material.

Research has been conducted on the feasibility of combining IRT and GPR. Donald
Jackson, Federal Lands Division of the Federal Highway Administration (FHWA), evaluated the
results of both techniques with regard to FRP wrapped concrete columns [17]. It was found that
GPR was a useful tool for monitoring progressive deterioration of the concrete inside the FRP
wrap. It was also observed that IRT is very effective in detecting blisters and shallow defects, as
well as entrapped moisture between the FRP and the concrete. These results show that the IRT
and GPR results compliment each other.

Kenneth Maser at Infrasence Inc. took this research one step further by setting up a Case
study involving the evaluation of the bridge decks of the two Grand Island Bridges, which are
over the Niagara River [24]. This study used infrared cameras in conjunction with standard color
video cameras to discriminate between infrared anomalies caused by defects and surface
conditions. This study also used GPR data collected from a 1 GHz air launch horn antenna
attached to a test vehicle traveling 20-30 mph. The results from each method were then
combined. The results were then tested by taking core samples from the defective areas of the
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bridge deck. The core samples were taken from locations that the IRT and GPR analysis
determined were defects. From all of this data it was concluded that 5 of 8 core samples were
from defective areas. It was also observed that both IRT and GPR methods may overestimate or
underestimate the degree of delamination. Lastly, the combination of IRT and GPR was found
to provide a reasonable estimate of the total quantity of concrete which is either damaged or in
questionable condition.

2.4 Automating IRT Analysis with Fuzzy C Means clustering
Since IRT analysis is performed by analyzing IR images, image analysis techniques can
be employed to automate the detection of subsurface defects. Many different algorithms, such as
thresholding, contouring, and morphology, have been used to identify defects in IR images. One
of the more powerful methods is Fuzzy C Means clustering.

Fuzzy C Means clustering (FCM) is an unsupervised data clustering technique wherein
each data point belongs to a cluster to some degree that is specified by a membership grade [21].
This technique was introduced as an enhancement to hard clustering methods in which a data
point either belongs to a cluster or it does not. It can group multidimensional data into a finite
number of data clusters. Image segmentation is a common use of FCM and a procedure using
fuzzy clustering has been exploited by researchers such as Horvath [15]. Modified versions of
the fuzzy clustering algorithm have also been used in the field of medical imaging [16]. For the
algorithm to work an initial guess of the cluster centers must be made. For example, in image
analysis a cluster would be a 3 dimensional <x,y,z> vector where the first and second dimensions
correspond to the image coordinates and the third dimension corresponds to the pixel value.
Most of the time, this initial guess is incorrect, but it provides a reference for future calculations.
Every data point is also assigned a membership grade for each cluster. This value is a number
between 0 and 1 that represents how well the data point fits in a certain cluster. A higher
membership grade means that it is likely that the data point belongs in that cluster and not the
others.
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After the initial guess of the cluster centers, the membership grades are updated. This
process calculates the Euclidean distance between the actual data and the cluster centers. The
results are then used to update the membership grades. The cluster centers are then updated with
the new membership grades and the process is repeated. The end result is that the cluster centers
move toward the centers of data clusters in the original data.

2.5 Summary
Based on previous research in this area, a system combines IRT and GPR would be
advantageous to the field of non-destructive testing. The system should incorporate active
heating, as well as automated data analysis, to reduce the survey time and increase the reliability
of the results.
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Chapter 3

Design of Active Heating System
3.1 Need
The increased use of FRP composites in many civil engineering applications has made it
highly important that engineers know how to detect subsurface defects in FRP decks. Naturally
an engineer would want to gather data quickly with as little work involved as possible. Both
GPR and IRT have shown promise in the field of non-destructive detection of defects. Even
though both technologies can be effective, they each have certain limitations, which can mean
that some defects may be missed due to the inability of the technique to recognize it. A logical
decision then would be to combine both technologies to see how they can be used together given
their combined strengths and weaknesses. For example, since one of the major disadvantages of
Infrared Thermography is the fact that it requires a temperature difference to detect structural
defects, a heat source of some kind must be used. For situations where passive heating can be
used, like on a nice sunny day, this is not a major issue. However, such sunny days are not
always available. This means that IRT testing cannot be used on-demand, but can only be used
whenever the weather is convenient. On the other hand, GPR is not limited by temperature and
can be used even on cold days. There are other ways that one technology complements the
other. GPR has been found to be sensitive to water-filled defects; infrared thermography;
however, is more sensitive to air-filled defects. By combining GPR and IRT a more complete
analysis of subsurface defects can be achieved.
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Also, it would not be very cost effective for someone to conduct an IRT analysis of a
deck and then a GPR analysis of the same deck. Saving time and money, as well as not having
to stop traffic for an extended amount of time, are some reasons it would be prudent to develop
some sort of automated way that an engineer can perform both tests simultaneously.

3.2 Active Heating System
Before any actual design work can be done on any project, a design criteria must be
determined. A design for a system that will house both IRT and GPR must take into account
that, while both techniques can be used to detect defects in an FRP deck, they are inherently
different technologies. IRT uses thermal radiation to measure differences in temperature over
defective and non-defective areas to analyze an FRP deck. This means that a heating source of
some kind is required so that data can be collected. This makes heating the FRP deck a crucial
part of the design of the UGV. This chapter will discuss research into an active heating system
to be mounted onto the UGV that will be used to prepare the FRP deck surface for analysis.

3.2.1 Simulated Defect Samples
Simulated defect samples were used for both the research into the active heating system
as well as the testing of the defect detection of the UGV. The first type of simulated defect was
an air filled void built directly into a Glass Fiber Reinforced Polymer (GFRP) bridge deck
specimen. These specimens, which were constructed to be similar to the ones used in GFRP
bridges, were bridge deck modules that were 2’ x 1’ (0.6m x 0.3m) in size. The GFRP decks
were composed of E-glass fibers and polyester resin combination. The specimen also had a
wearing surface layer 3/8” (9.5 mm). The specimen contained simulated 3” x 3” and 2” x 2”
debonds that were located between the 3/8” wearing surface and the underlying FRP deck.
Figure 3-1 shows a sample GFRP deck specimen.
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Figure 3-1 Bridge deck specimen with embedded defects [32].

The second type of simulated defect involved wearing surface slabs with notches cut out
on the underside of wearing surface that were then placed on FRP decks. This was done to
simulate debonds between the wearing surface and the top of the FRP deck. These notches were
either left empty to simulate an air filled debond or filled with a water pouch to simulate a water
filled debond, and could be changed during testing to create different defect scenarios. These
simulated defects were created by Vasudevan [32] and Cheng Hing [14] to facilitate their
research. These simulated defects were used during both the GPR and IRT testing. Figure 3-2
shows the bottom side of a wearing surface slab with one 2 inch x 2 inch simulated air filled
debond and two simulated water filled debonds, which had plan sizes of 3 inches x 3 inches and
4 inches x 4 inches.
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Figure 3-2 Bottom side of the wearing surface slab showing 2 water filled debonds (left and right
sides) and 1 air filled debond (center) [14].

3.2.2 Experimental Setup for Determining the Best Heating Source
Passive heating from the sun was considered along with active heating provided by
various electric and propane heaters. Regardless of the heat source used for the testing, analysis
for each case was conducted using the same method. The GFRP bridge deck specimen with
embedded defects was used. The specimen was heated for a specific amount of time. If the test
involved cooling, the specimen was then cooled with liquid CO2, for a specific time. IR images
were then recorded using a FLIR ThermaCAM S60 IR camera. A set duration of recording time
was not specified but for analysis only the first 50 seconds of each trial was used. It was
experimentally determined that after 50 seconds nothing new would appear on the images and if
something else did appear that it was well outside of a reasonable analysis time.
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3.2.3 Issues with Passive Heating
Using passive heating, such as the sun, would be the most cost efficient heating
alternative. To assess sunlight as a viable option, a solar heating test was conducted. The
specimen was left outside for 1 hour on sunny days where the ambient temperature was 60ºF
(day 1), 70ºF (day 2), and 80ºF (day 3). During all tests, the specimen was left outside at 1:00pm
and the temperature readings were taken at 2:00pm. Previous research indicated that this time of
day would produce good results [32]. Figure 3-3 shows the difference in surface temperature
between the two defect areas (3 inches x 3 inches and 2 inches x 2 inches) and the surrounding
defect free areas for day 1. Figure 3-4 shows the resulting IR image from the same day. Figures
3-5 and 3-6 show the data acquired from the testing on day 2. Figures 3-7 and 3-8 show the data
acquired from the testing on day 3.

The results of this test show that when using solar heating as a heat source, large defects
can be seen easily with IR imaging. This is not ideal because smaller defects would evade
detection. Active heating, as shown in the next section, allows for smaller defects to be seen.
Another reason using solar heating is not feasible for automated image acquisition is that various
objects, such as clouds, trees, and guard rails, can block sunlight from getting to some areas of
the deck. This would lead to differences in the heating of the deck and unreliable data collection.
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Temperature Differences after solar heating for 1
hour (ambient temp 60ºF)
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Figure 3-2 Temperature Differences from day 1.

Figure 3-3 IR image of specimen from day 1.
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Temperature Differences (C)

Temperature Differences after solar heating for 1
hour (ambient temp 70ºF)
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Figure 3-4 Temperature Differences from day 2.

Figure 3-5 IR Image of specimen from day 2.
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Temperature Differences (C)

Temperature Differences after solar heating for 1
hour (ambient temp 80ºF)
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Figure 3-6 Temperature Differences from day 3.

Figure 3-7 IR image of specimen from day 3.
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3.2.4 Testing of Active Heating Methods
Since passive heating has been shown to be unreliable for autonomous data collection,
testing was done to determine the best active heating method. Three different heaters were
analyzed. The first heater was a 5000 BTU quartz heater, model number 7260, designed by
W.B. Marvin Mfg. Company. The second was a 9000 BTU propane convection heater, model
number MH9B, designed by Mr. Heater. The last was a 35000 BTU forced air propane heater,
model number SPC35, designed by All Pro Portable Heaters. Figures 3-9, 3-10, and 3-11 show
the 5000 BTU, the 9000 BTU [37], and the 35000 BTU heaters [38], respectively.

The first test was conducted indoors using the 5000 BTU electric heater. Trials were
conducted with heating times of 10 seconds, 20 seconds, and 30 seconds. In addition, the
effectiveness of cooling via liquid CO2 was also tested. In one trial, the deck specimen was
heated for 10 seconds and then cooled for 2 seconds. In other trials, the same procedure was
used with 20 and 30 second heating times. Figures 3-12 through 3-23 show the temperature
differences and resultant IR images for all the trials.
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Figure 3-8 5000 BTU Electric Heater.

Figure 3-9 9000 BTU Propane Heater.

Figure 3-10 35000 BTU Forced Air Propane Heater.
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Figure 3-11 Temperature Differences after heating for 10 seconds with 5000 BTU quartz heater.

Figure 3-12 IR image after heating for 10 seconds with 5000 BTU quartz heater.
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Temperature Differences after heating 20 seconds
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Figure 3-13 Temperature Differences after heating for 20 seconds with 5000 BTU quartz heater.

Figure 3-14 IR image after heating for 20 seconds with 5000 BTU quartz heater.
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Temperature Differences after heating 30 seconds
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Figure 3-15 Temperature Differences after heating for 30 seconds with 5000 BTU quartz heater.

Figure 3-16 IR image heating for 30 seconds with 5000 BTU quartz heater.
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Temperature Differences (C)

Temperature Differences after heating 10 seconds
and cooling 2 seconds
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Figure 3-17 Temperature Differences after heating for 10 seconds with 5000 BTU quartz heater
and CO2 cooling.

Figure 3-18 IR image after heating for 10 seconds with 5000 BTU quartz heater and CO2 cooling.
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Temperature Differences after heating 20 seconds
and cooling 2 seconds
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Figure 3-19 Temperature Differences after heating for 20 seconds with 5000 BTU quartz heater
and CO2 cooling.

Figure 3-20 IR image after heating for 20 seconds with 5000 BTU quartz heater and CO2 cooling.
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Temperature differences after heating 30 seconds
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Figure 3-21 Temperature Differences after heating for 30 seconds with 5000 BTU quartz heater
and CO2 cooling.

Figure 3-22 IR image after heating for 30 seconds with 5000 BTU quartz heater and CO2 cooling.
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The result of these tests was the demonstration of improved defect detection using a small
heater. The images in Figures 3-13, 3-15, and 3-17 clearly show the larger defect on the left.
The smaller defect is not visible in the 10 second trial, somewhat visible in the 20 second trial,
and fully visible in the 30 second trial. Also, it can be seen that the addition of a cooling step
after heating can produce slightly better visual results; however, there is a slight decrease in the
temperature difference between the defect and defect-free areas. This difference is less
noticeable as the heating times increase because higher heating times force more heat below the
surface and as a result takes more effort to remove. Also, care has to be taken that the cooling
does not negate the effects of the heating. An example of this can be seen in Figure 3-23. The
larger defect is less defined after the cooling than it was in the corresponding trial without
cooling.

Despite the promising results from this test, this heating method was not implemented in
the UGV design. This heater runs at 1500 Watts. This would place a significant drain on the
UGV batteries. For this reason other heating methods were explored.

The next test involved testing with a 9000 BTU propane convection heater. The heater
used a small 1 lb. propane tank. The logic behind this test was that a stronger heater would
require less heating time to produce the same results. Trials 1, 2, and 3 were conducted with
heating times of 10 seconds, 20 seconds, and 30 seconds, respectively. In addition, cooling via
liquid CO2 was implemented. In trial 4, the deck specimen was heated for 10 seconds and then
cooled for 2 seconds. Figures 3-24 through 3-31 show the temperature differences and resultant
IR images for all the trials.
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Figure 3-23 Temperature Differences after heating for 10 seconds with 9000 BTU propane heater.

Figure 3-24 IR image after heating for 10 seconds with 9000 BTU propane heater.
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Figure 3-25 Temperature Differences after heating for 15 seconds with 9000 BTU propane heater.

Figure 3-26 IR image after heating for 15 seconds with 9000 BTU propane heater.
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Figure 3-27 Temperature Differences after heating for 20 seconds with 9000 BTU propane heater.

Figure 3-28 IR image after heating for 20 seconds with 9000 BTU propane heater.
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Figure 3-29 Temperature Differences after heating for 15 seconds with 9000 BTU propane heater
and CO2 cooling.

Figure 3-30 IR image after heating for 15 seconds with 9000 BTU propane heater and CO2
cooling.
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The results of this test were less promising than previously expected. The reason for this
is the method of heat conduction. The 9000 BTU heater is designed to operate standing
vertically. It cannot be turned so that heat is directed downward because then it would run the
risk of catching fire and eventually exploding. This meant that during the test the specimen also
had to be standing vertically. This limited the affected area on the specimen. This could
possibly have been avoided if the specimen were moved back and forth like the 5000 BTU heater
was during its testing. The size and weight of the deck specimen; however, prevented this from
being done easily. Since the UGV was designed to survey FRP bridge decks, and bridge decks
are generally horizontal not vertical, this heating method could not be used. Even though it may
have produced viable data, it would be highly unsafe.

Still holding with the idea that a stronger heating method would produce more efficient
results, a 35000 BTU forced air propane heater was tested. Trials 1, 2, and 3 were conducted
with heating times of 10 seconds, 20 seconds, and 30 seconds, respectively. Figure 3-32 through
3-37 show the temperature differences and resultant IR images for all the trials.
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Figure 3-31 Temperature Differences after heating for 5 seconds with 35000 BTU forced air
propane heater.

Figure 3-32 IR image after heating for 5 seconds with 35000 BTU forced air propane heater.
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Temperature Differences after heating for 10
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Figure 3-33 Temperature Differences after heating for 10 seconds with 35000 BTU forced air
propane heater.

Figure 3-34 IR image after heating for 10 seconds with 35000 BTU forced air propane heater.
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Figure 3-35 Temperature Differences after heating for 15 seconds with 35000 BTU forced air
propane heater.

Figure 3-36 IR image after heating for 15 seconds with 35000 BTU forced air propane heater.
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The results of this test showed that even after only 5 seconds of heating a temperature
differences of 2 degrees can be observed around the 3” by 3” defect. Both the large defect and
the smaller defect were clearly visible, though the temperature difference of the small defect was
not as large as expected. One of the main highpoints for the forced air heating is that it provides
a uniform heating, which is preferable in IR analysis. This was the heating method chosen for
implementation on the UGV because it provided uniform heating and only minor modifications
are needed to be able to mount it on the UGV.

3.2.5 Design of Active Heating System
After performing the preliminary IR analysis with a number of heaters, the 35000 BTU
forced air heater was chosen because of its fast consistent heating and reliable defect detection.
Since this heater forces air forward to heat a surface, it provides very direct, even heating. The
only downside is that the heater is oriented so that it directs heat forward and not down. Since it
would not be safe to operate the heater in an orientation other than the designed direction, an
aluminum heat shroud was designed to conduct the heat produced by the heater down to the FRP
deck. This shroud is 6 inches x 6 inches at the top and expands to 13 inches x 13 inches at the
bottom. The heater was then mounted to an aluminum box to allow for air circulation and
cooling of the deck before IR imaging is done. The heater was then inserted into the cone
through a hole cut in one side. The fan that originally came with the heater was replaced with a
PWM controlled motor [39] so the strength of heating could be controlled. Two adjustable
cooling fans were also added to the heating system to provide optional cooling steps. From the
research conducted in the previous sections, it can be determined that better results are observed
if there is sufficient time between heating and temperature measurement. This design, with its
two cooling sections, provides this time delay. Figure 3-38 shows a block diagram of the final
design for the active heating element.
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Figure 3-37 Block Diagram of the Active Heating Element.

3.2.6 Testing of Active Heating System
Before mounting the active heating element onto the UGV it had to be tested. These tests
were conducted to look for accurate results and structural durability. For these tests, wheels
were mounted onto the sides of the heating element with strips of FRP angle bar so that it could
be moved easily. The heater was then placed on an FRP deck with embedded defects and turned
on. It heated the deck surface for 15 seconds and then was moved forward so that the next area
could be heated. Figure 3-38 shows the temperature differences resulting from this test. Figure
3-39 shows the resulting IR image
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Figure 3-38 Temperature Differences after heating for 15 seconds.

Figure 3-39 IR image after heating for 15 seconds.
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The results of this test showed that this design produced even heating and could be used
very reliably in the UGV design. The 3 inch x 3 inch defect in on the left of the image is clearly
visible. The 4 inch x 4 inch defect in on the right of the image is visible, but not completely
clear. It is clear that something is there but we cannot determine its exact shape. The
discontinuities in the middle of the image come from human error when moving the heating
element across the deck. These minor errors are virtually eliminated; however, when the heating
element is mounted on the UGV. The reason for this is the movement of the heating element is
more precisely controlled by the motors and encoders on the UGV as compared to simply using
human judgement to move the heating element the correct distance.

3.3 Summary of Passive and Active Heating
Passive heating is not a feasible heating method to be used in conjunction with the UGV
due to various problems, such as dependency on weather and possible uneven heating. By using
active heating, the UGV will avoid the problems that can occur with passive heating. It can be
observed from the data presented in this chapter that a stronger active heating source allows for
faster defect detection in the IR images. The active heating system that was designed is able to
produce good quality IR images after heating a FRP deck for only 15 seconds. This heating time
of 15 seconds produces a combined preparation time of 45 seconds (15 seconds of heating and 2
stages of cooling at 15 seconds each).
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Chapter 4

Design of UGV
4.1 Design Goals
The overall goal of this research is to produce a UGV capable of surveying an entire FRP
bridge deck with both IRT and GPR analysis. The UGV will be expected to perform this task
quickly and efficiently. The UGV is also expected to perform its task autonomously, with little
or no human intervention. To accomplish this task, an approach called pipelining was
incorporated into the UGV design.

4.2 Pipelining the Analysis Process
The pipelining process basically divides the overall task of analyzing an FRP deck into
smaller tasks, such as GPR analysis, heating, cooling and IRT analysis, and performing these
subtasks in a sequential order. The active heating system, described in the previous chapter, was
designed with this idea in mind. Its task, which is to prepare the deck surface for IRT analysis, is
divided into smaller tasks, heating and cooling. Afterwards, a section of the active heating
system was designated to perform each subtask. This subdivision of labor allows the active
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heating system to prepare the FRP deck in stages. Figure 4-1 shows the pipelining that the active
heating system performs.

Figure 4-1 Pipelining of Active Heating System.

The diagram shows how the pipelining process can streamline the preparation of the FRP
deck. When the process begins, at time T0, nothing is happening because this represents the start
of analysis. The heating of the first section is done at time T1. At time T2, heating is performed
on the second section of deck while the first section is going through a cooling stage. Time T3
marks the beginning of heating for the third section of deck while sections 1 and 2 are
undergoing cooling stages. This process continues until each section undergoes 1 heating stage
and 2 cooling stages. Based on this method, a design for the actual implementation of the UGV
was developed. Figure 4-2 shows a block diagram for the layout of the UGV.
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Figure 4-2 Block Diagram of UGV Layout.

This incremental model allows the pipelining process to be extended to include the entire
UGV. Figure 4-3 shows the pipelining process for the UGV.

Figure 4-3 Pipelining Performed y the UGV.
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This pipelining method attempts to minimize the amount of time it takes to survey an
FRP deck. GPR analysis is conducted first. This is because one of the strengths of GPR is the
detection of water filled defects, and the heat generated by the active heating system may
decrease the amount of water present in any such defects. After GPR analysis is conducted, the
deck surface can then be prepared for IRT analysis by the heating and cooling stages. At the end
of time period T5 an IR image of the FRP deck surface is obtained. After this point, IRT
analysis will be conducted at every interval because the next section of deck has already been
prepared.

Now that the method of movement for the UGV has been determined, the next step in the
design process is to decide on the movement and time intervals that will be implemented in the
pipelining process.

The movement intervals are determined by the size of defects that can be detected with
IRT and GPR. The smallest defect that can be detected reliably by IRT and GPR is
approximately 2 inches by 2 inches [14, 32]. Another factor that was considered was the area
that each GPR antenna could survey. Each GPR antenna has a 6 inch wide footprint. Two
antennas can be used simultaneously to provide the UGV with the ability to survey a 12 inch
wide strip. Since the maximum width of the GPR analysis is 12 inches, the IR images that were
collected from the IR camera were cropped from 320 pixels by 240 pixels to 240 pixels by 240
pixels by eliminating area on the sides of the image. This means that the IR images will now
have a 12 inch by 12 inch area of interest. Because of this, every 20 pixels in the image
correspond to 1 inch of the deck, which correlates into a minimum defect size of 40 pixels by 40
pixels. This was experimentally determined to provide sufficient data to analyze the IR images.

The timing intervals are determined by the heating and cooling times required to produce
good IRT analysis. It was experimentally determined during the active heating system design
that generally no new defect information will be collected from an IR image after 50 seconds. It
was also determined that longer heating times produce clearer defect images. For these reasons,
a timing interval of 15 seconds was implemented by the UGV. This gives a heating time of 15
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seconds and a cooling time of 30 seconds. This ensures a long heating duration to produce clear
IR images and more than enough cooling time to allow any defects to be seen on the IR image.

The last element of the design is to determine how to apply this pipelining process to an
FRP deck. Most FRP decks are rectangular. This simple geometry lends itself very nicely to the
pipelining scheme. The deck can be divided into strips. The UGV can analyze one strip of the
deck and then turn around and analyze the next strip. Figure 4-4 shows a graphical
representation of this analysis scheme.

Figure 4-4 Method of Analysis for FRP Deck.
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The UGV can start at one end of the deck. It will then move in 12 inch increments to
collect both GPR and IRT data using the pipelining method. When it gets to the end of the deck,
the UGV can then turn around. After turning, it will analyze the next strip of deck. It can then
continue in this fashion until the entire deck is surveyed. Using this method with the pipelining
is very efficient. Using intervals of 15 seconds with 1 foot increments means that surveying an
FRP deck that is 50 feet long by 20 feet wide would take approximately 4.6 hours.

While this method provides an efficient way to survey an FRP bridge deck, it does not
completely survey the deck. The reason for this is that the GPR antennas can only distinguish
data in the direction of motion. Basically since the antennas have a 6 inch footprint, any defects
detected in that 6 inch area will show up as a defect in the resulting waveform. This means that
to completely acquire GPR data on an FRP deck data must be collected in one direction and then
data must then be collected in the perpendicular direction. Figure 4-5 shows a diagram of the
data acquisition described here.

Figure 4-5 Complete GPR survey of an FRP deck
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This method of data acquisition was not implemented on the UGV for a couple of
reasons. First this method of data acquisition only benefits the GPR data collection. This is
because that the IR images that are taken by the UGV are 2-D images that have both a length and
a width. Performing this type of data acquisition would essentially mean that each area of the
FRP deck would be surveyed twice with IRT for every one time with GPR. The other main
reason that this method was not implemented would be that it would increase the overall survey
time considerably. If one was to consider the same 50 feet long by 20 feet wide FRP deck
discussed earlier, this method would add another 5.2 hours to the overall analysis time. This
would more than double the aforementioned time of 4.6 hours.

4.3 Physical Implementation of UGV
Figure 4-6 shows the final implementation of the UGV. Figure 4-7 shows a block
diagram of how the various components of the UGV are connected.

Figure 4-6 Final Physical Implementation of UGV.
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Figure 4-7 Hardware block diagram of the UGV.

The UGV was designed to accommodate the pipelining technique discussed earlier. This
means that the UGV has 3 basic sections: the GPR analysis section, the active heating system,
and the IRT analysis section.

The front section of the UGV contains the GPR antennas used for analysis. The 1.5 GHz
antennas [7] that were mounted on the UGV have an analysis footprint of approximately 6
inches. Since the UGV would be surveying 1 foot wide strips of an FRP deck at a time 2 of them
were mounted. The antennas themselves are housed in a plastic tray. This tray rides along the
ground and protects the antenna from wear and tear by providing a buffer between the ground
and the antennas. The plastic tray allows the radiation emitted by the antennas to pass directly
through it and into the deck surface for analysis. The antennas are connected to a SIR-20 GPR
data acquisition system [30] designed by Geophysical Survey Systems, Inc, which is located on
the upper deck of the UGV.
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The active heating system is located in the middle of the UGV. This positioning allows
the active heating system to prepare the FRP deck for IRT analysis. IRT analysis is done by a
FLIR ThermaCAM A20M infrared camera [5]. This 320x240 resolution camera takes infrared
images of the deck and sends them via a firewire connection to a laptop computer located on the
upper deck of the UGV. Figure 4-8 shows a picture of the ThermaCAM A20M camera.

Figure 4-8 FLIR ThermaCAM A20M infrared camera. Picture taken from FLIR website [5].

The UGV frame itself is made out of 1.5 inch x 1.5 inch fiberglass T-slotted bar. These
bars are very sturdy, corrosion resistant, and are non-conductive to lessen electromagnetic
interference on the GPR system.

To allow the UGV to move, a 12V DC motor from NPC Robotics [27] was mounted on
each side of the UGV. A VICTOR 883 motor controller from IFI Robotics [16] was used to
control each motor. Figure 4-9 shows a picture of the VICTOR 883.
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Figure 4-9 VICTOR 883 Motor Controller. Picture taken from IFI website [16].

On each motor, a modified VEX optical shaft encoder [33] was installed to monitor the
velocity of the UGV by counting the revolutions of the motor. Figure 4-10.shows the 12V DC
motor with the modified VEX encoder mounted.

VEX
Optical
Shaft
Encoder

Figure 4-10 12V DC motor with modified VEX encoder.
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To provide enhanced mobility, omni-wheel casters [2] were used as front and rear
wheels. These wheels have rollers on their sides to decrease the amount of friction when the
wheel is sliding. By using these wheels, the UGV minimizes its skid and steer friction. Figure
4-11 shows a picture of the omni-wheels.

Figure 4-11 Omni-wheel used for front and rear wheels.

The UGV is powered by two 17 Ah Gel Cell lead acid 12V batteries. One battery is used
to power a 300W AIMS Power pure sine wave inverter [1] which is mounted on the underside of
the upper-deck. The power inverter provides AC power to the GPR data acquisition system, the
controlling laptop, and the IR camera. Figure 4-12 shows a picture of the AIMS power inverter.
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Figure 4-12 AIMS power inverter.

The second battery is used to power the motors, the motor controllers, and the heating
and cooling motors [39]. The UGV uses two batteries because this isolates each circuit. This
means that a stall in a motor, for example, would not cause a drop in power for another
component.

At the heart of UGV is a VEX robot controller [34]. This controller is mounted on the
underside of the upper-deck. The VEX robot controller is responsible for generating the PWM
signals that will control the motors. It also reads the optical encoders and uses a PID control
algorithm to autonomously control each motor’s velocity.

4.4 Autonomous Control of UGV
The autonomous movement and data acquisition of the UGV will be controlled by a
laptop computer located on the upper deck of the UGV. Figure 4-13 shows what the GUI on the
laptop looks like.
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Figure 4-13 GUI Application on the Controlling Laptop.

This program controls the data acquisition and motion of the UGV. For information
pertaining to the use of this program consult Appendix C found at the end of this thesis.
Autonomous data acquisition begins when the operator clicks the “Enable Auto Acquisition”
button. Figure 4-14 shows a flow chart of the basic control algorithm.

54

Figure 4-14 Flow Chart for Autonomous Movement and Data Acquisition.

4.5 Automatic Defect Detection in IR images
Since the goal of this research is to develop a fully functional defect analysis system for
FRP decks, automated image analysis algorithms have been implemented to provide defect
detection. The goal was to create a detection algorithm that was robust, but at the same time
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could perform the analysis quickly enough to be implemented on the UGV for real time defect
detection. Image processing algorithms have already been implemented for analyzing IR images
for defects [13]. While these algorithms have shown good capabilities in identifying defects,
their processing times and their implementation do not allow for their use in real time
applications. To this end, 3 different algorithms were developed to detect defects from the
images that the UGV generates. The first is a very simple, but highly effective, method
consisting of grayscale thresholding. The second algorithm is a similar algorithm but it does its
thresholding on the actual temperature values of the IR images instead of the grayscale pixel
values. The last algorithm uses a fuzzy C-means clustering algorithm on the temperature data to
cluster like values together.

4.5.1 Analyzing IR images with grayscale thresholding
The grayscale thresholding algorithm that was first implemented uses the grayscale
image captured from the camera for its data. The grayscale pixels are subjected to a simple
algorithm involving 2 basics steps: gray level quantization, and thresholding. The first step, gray
level quantization, is done to make different gray levels easier to distinguish. By reducing the
image from 256 gray levels to around 12 gray levels, makes the edges of each region in the
image much more defined. To reduce the number of gray levels, a cumulative histogram is
obtained. This histogram is divided into 2 regions at the median of the histogram. Each new
region is divided again at its new median. The process continues until there are 12 regions. The
gray values that fall in these regions are then remapped to the average pixel value of that
particular region. Figure 4-15 shows the histogram of an image on the left and the histogram of
the same image after quantization.
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Figure 4-15 Histogram of an Image before and after grayscale quantization.

The second step is thresholding. Since the image has been quantized into fewer grayscale
values, the threshold is simply the highest pixel value of the image. Any pixel that is less than
the threshold is changed to black and any pixel that is equal to the threshold is changed to white.
The image is then inverted and combined with the original IR image. The end result of this step
is that it removes everything in the image except the pixels that are the same intensity as the
whitest spots, which usually correspond to defect areas. Figure 4-16 shows an image of an FRP
deck specimen with two embedded defects, a 2 inch x 2 inch air filled defect in the upper section
and a 3 inch x 3 inch air filled defect in the lower section.
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Original IR Image

IR Image with Reduced Gray Levels

Defects found with Local Max

Original IR Image with Defects Highlighted

Thresholding
Figure 4-16 Defect Analysis of FRP Specimen with Built-in Defects using Grayscale Thresholding.

In this test this basic algorithm performed well. Both defects in the specimen were
detected. It is a simplistic algorithm so the data processing time is small, typically less than 0.5
seconds. This fact coupled with the success of defect detection in the test images led to the
conclusion that this algorithm could be implemented on the UGV for real time analysis of
defects. After being implemented, images were collected from the UGV and analyzed with this
method. The images captured the UGV are not as clear as the test images shown in Figure 4-15.
There is noise present and the defects are not as easily seen. As a result, the algorithm does not
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perform quite as well at analyzing the images obtained by the UGV as it does with the test
images. While it does detect the defects that are present in the images, the algorithm tends to
generate a lot of false positives, which are cases where the algorithm finds a defect where none
exist. Figures 4-17, 4-18, and 4-19 show images obtained by the UGV and the resulting defect
images.

Figure 4-17 IR image of 2" x 2" air filled defect and results of analysis by grayscale thresholding.

Figure 4-18 IR image of 3" x 3" air filled defect and 2” x 2” air filled defect and results of analysis
by grayscale thresholding.
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Figure 4-19 IR image of 2" x 2" air filled defect and 3” x 3” air filled defect and results of analysis
by grayscale clustering.

In Figure 4-16 the defect is clearly visible in the original image, and is highlighted in the
defect image. There is much more highlighted in the defect image than just the defect. This is
caused by those pixels being grouped together with the defect pixels during quantization. The
images in Figure 4-17 show very good defect detection. The defects are clearly discernible in
the defect image. The results from Figure 4-18 also show good defect detection. The problem
with this set of images is that the 2” x 2” defect in the top part of the image is not recognized.
This is because the defect is faint and almost blends in with the surrounding pixels. This
algorithm tends to work well on images where the defects are visibly discernible. Since the
whole point of automated detection algorithms is to detect defects that are not visible to the
naked eye, this algorithm also had to be tested with images that were not as clear. Figure 4-20
shows an image obtained by the UGV where the defect is not clearly discernible and the results
when analyzed with this algorithm. The circles of the left image denote where the simulated
defects are embedded.
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Figure 4-20 Fuzzy IR image of 2" x 2" air filled defect and 3” x 3” air filled defect and results of
analysis by grayscale clustering.

While the highlighted areas are centered on the actual defect location, some noise can be
observed in the defect image. Overall, the grayscale thresholding algorithm does produce very
fast, moderately accurate results with fairly simple unsophisticated techniques.

4.5.2 Analyzing IR images with temperature thresholding
Since the basic idea behind computer aided image analysis is to detect objects in images
that a human observer would not be able to see, a more accurate analysis method had to be
implemented. While grayscale images are easier to visually inspect, the temperature data may
actually provide more precise analysis. The temperature thresholding algorithm uses the
temperature data captured by the camera to perform its analysis. The entire image is thresholded
with a set temperature value. If the temperature value at any point in the image is greater than the
threshold then the corresponding pixel in a grayscale image is highlighted. This is done so the
defects can be seen visually when the analysis is done. The threshold is then increased and the
process is repeated again. The levels are chosen so that each temperature level represents, at the
most, a range of 0.025ºC. This means that since the most of the images have approximately
10ºC difference between the lowest and highest temperature values, there will end up being 400
temperature levels. The end result is a series of images that represent temperature levels in the
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data. Figure 4-21 shows how the progression of the temperature levels throughout the execution
of the algorithm.

Original Image

Threshold Level 50

Threshold Level 60

Threshold Level 70

Threshold Level 75

Defect Image

Figure 4-21 Progression of temperature levels during the temperature mapping method.

One of the advantages of this method of analysis is that it has the ability to find defects in
very fuzzy IR images. The precision of the temperature data allows it to be analyzed much more
accurately than the grayscale pixels in the grayscale clustering method. For increased accuracy,
the number of temperature levels that are found could be increased. This would add very little
processing time since the actual processing is very small. This was also the fastest method that
was implemented for image analysis on the UGV. Despite all the positives about this particular
method, there is one blaring negative that cannot be avoided, which is where to stop the
temperature level mapping. For the image shown above the best possible result was at
temperature level 76. Each IR image will have a different temperature level that corresponds to
the defects in the image. With no intelligent way of determining the cut-off for each image, this
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method can not be reliably used for automatic defect detection. That does not mean that this
method is worthless. The temperature mapping algorithm could be very beneficial as a manual
analysis method. If an NDT engineer was surveying an FRP deck and he could look at the
temperature levels of each image, he or she could very easily scroll through the levels and pick
out the defective areas in the deck. Since the goal of the UGV is to produce autonomous results,
another analysis algorithm had to be implemented.

4.5.3 Analyzing IR images with Fuzzy Clustering
Fuzzy clustering of IR image pixels has been performed by other researchers. Accurate
defect detection is possible with fuzzy clustering. To increase the accuracy of defect detection,
temperature values were clustered instead of clustering the grayscale image pixels, which was
done by Lonkar [13]. Since the temperature mapping algorithm showed that increased accuracy
could be obtained from the temperature data, this seemed like a logical step. Figures 4-22 and 423 show the results of analyzing images obtained by the UGV with the FCM algorithm.

Figure 4-22 IR image of 2" x 2" air filled defect and results of analysis by fuzzy clustering
algorithm.
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Figure 4-23 IR image of 2" x 2" air filled defect and 3” x 3” air filled defect and results of analysis
by fuzzy clustering algorithm.

The FCM algorithm assigns each temperature value in the image to a cluster. The
clusters with the highest temperature values are then chosen to represent the subsurface defects
in the image.

Judging from these images it could be said that the fuzzy clustering on the temperature
values provides an accurate method for defect detection. These images only represent
temperature data from clearly discernible defects. For images that have less obvious defects, the
fuzzy clustering algorithm must be improved, such as adding more clusters to the algorithm, to
provide reliable results. The number of clusters has a large effect on the fuzzy clustering
algorithm. By adding more clusters, it is possible to detect defects in images that cannot be seen
by the naked eye. Figure 4-24 shows an IR image being analyzed with the fuzzy clustering
algorithm. The middle picture is the result when clustering with 6 clusters. The image on the
right is the result of clustering with 12 clusters.
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Original IR image

Analyzed with 6 clusters

Analyzed with 12 clusters

Figure 4-24 IR image of 4" x 4" air filled defect and results of analysis by fuzzy clustering
algorithm with 6 clusters and 12 clusters.

The defect generated at the interface between the slabs is detected in both cases because
this is the hottest spot in the image. The 4 inch x 4 inch defect is not found with 6 clusters but is
detected with 12 clusters. The temperature difference between the defective area and the
surrounding defect-free area is approximately 0.8ºC. This means that less heating is required for
defects to be detected. The downside to using 12 clusters is that the algorithm takes much longer
to compute, roughly 25 seconds, on a PC, than it does with 6 clusters. The algorithm takes
roughly 5 seconds on a PC to process the data with 6 clusters. Experimenting with different
numbers of clusters: 7, 8, 9, etc. could produce an optimum solution to the trade-off between
accuracy and the execution time. On the plus side the FCM algorithm may be able to provide
real time defect detection during testing with the UGV. It may be possible to employ multithreaded code to allow the image analysis to be done in one thread while another controls the
movement of the UGV. That way accuracy would not have to be sacrificed for speed. Neither
the implementation of different numbers of clusters nor multi-threading was implemented on the
UGV however due to time constraints and inexperience.
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4.5.4 Comparison of Image Analysis Techniques
To quantify the results of the 3 different image analysis algorithms, defect analysis was
conducted on a number of images obtained by the UGV during testing. Twenty four IR images
with a total of 48 defects were subjected to each algorithm. The grayscale thresholding
algorithm performed the worst out of the 3 algorithms. Out of 48 defects 40 or 83% were
correctly identified, while 21% of the images reported false positives. The temperature
thresholding algorithm performed a little better, correctly identifying 85% of the defects with
only 16% of the analyzed images producing false positives. The Fuzzy C Means algorithm
performed the best, though. It correctly identified 42 out of 48, or 87.5% defects while only
generating false positives in 8% of the analyzed images.
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Chapter 5

Experimental Setup and Results
5.1 Experimental Limitations
All tests that were conducted during this research were laboratory tests. As a result, no
testing was done on a full FRP deck. Individual tests were conducted on smaller FRP deck
samples as well as a concrete floor. Individual tests were either conducted with IRT analysis or
GPR analysis.

5.2 Testing of Autonomous Control Algorithm
Since the majority of actions performed by the UGV are autonomous, the algorithm that
will move and control the UGV had to be tested to insure accurate data acquisition. To test the
quality of the autonomous control, a GPR survey would be conducted on a surface using the
autonomous movement of the UGV. The objective of the test was to produce a 3D map of the
surveyed concrete floor showing the metal plates as well as any subsurface features, such as
rebars.
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5.2.1 Experimental Setup
A 10 foot x 5 foot area on a machine shop’s concrete floor was sectioned off with
aluminum tape. The aluminum tape was used to mark the beginning of a measurement. This
means that since virtually all of the electromagnetic radiation is reflected by the aluminum tape,
the tester knows where to begin looking for defects. The UGV was supposed to survey the area
as it would an FRP deck. The area chosen had rectangular metal plates spaced evenly at every 3
feet as well as rebar embedded in the floor. Once the UGV was running and the GPR acquisition
was begun, the size of the “deck” was fed into the GUI running on the controlling laptop. Figure
5-1 shows what the setup for this test looked like.

Figure 5-1 Setup for Testing the Autonomous Motion of the UGV.
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5.2.2 Experimental Results
Three different trials were conducted to see if the control algorithm performed
consistently and reliably. The GPR data that was gathered was then segmented into smaller files
each representing a strip of the deck. The 3D mapping software then stitches these files together
to create a model of the entire decks. Figures 5-2, 5-3 and 5-4 show 3D map that were generated
with the data collected during this testing. It is important to note that the rebars shown are only
in the x direction, even though a rebar mat is typically both in the x and y directions. For an
explanation of why this occurs consult section 4-2.

Figure 5-2 3D maps obtained during Autonomous Motion Testing.
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Figure 5-3 3D maps obtained during Autonomous Motion Testing.

Figure 5-4 3D maps obtained during Autonomous Motion Testing.
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5.2.3 Conclusions from Experiment
The rebars underneath the concrete floor are clearly visible and straight; however, they do
not line up precisely. This has more to do with the way the data collected was analyzed then the
actual data collection. When analyzing the GPR data, the beginning and ending points for the
data are user defined and can introduce some error. The rectangular metal plates appear in the
3D map as bright white rectangular areas, which are evenly spaced and easily discernible. The
results from this test show that the data being collected during the autonomous motion is very
consistent. The metal plates appear in the same places in all the images. The same can be said
for the rebars. This means that the results from this test are repeatable. From this test it is safe to
assume that if the UGV is given the length and width of an FRP deck, the UGV will be able to
autonomously survey the FRP deck.

5.3 Testing of GPR Defect Analysis
Since the GPR system will be used to test for water filled defects, testing was done to
determine the accuracy of the analysis. The main purpose for this testing was to figure out how
to efficiently employ a two GPR antenna system, as opposed to the common one antenna system.

5.3.1 Experimental Setup
For this test the simulated defects described in the previous section were used. The
notches were filled with water pouches. Defects of plan sizes 2” x 2”, 3” x 3”, and 4” x 4” were
used. The wearing surface with the simulated defect samples were placed on an FRP deck. The
GPR data acquisition was then started and the UGV moved the antennas over the wearing
surfaces slabs. Figure 5-5 shows the setup for this experiment. Aluminum tape was used to
mark the beginning of a measurement. This lets the tester know where to begin looking for
defects, because virtually all of the electromagnetic radiation is reflected by the aluminum tape.
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Figure 5-5 Wearing surface slab with simulated defects on top of an FRP deck during testing.

5.3.2 Experimental Results
GPR data was collected for defects of various sizes. The water filled debonds were
detected very efficiently using the GPR data. Bigger defects were more discernible than smaller
defects, but defects as small as 2 inches x 2 inches were visible. Figure 5-6 shows a GPR scan
of a 2 inch x 2 inch defect. Figure 5-7 shows a GPR scan of a 4 inch x 4 inch defect and 3 inch x
3 inch defect.
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Figure 5-6 2" x 2" water filled defect observed in the data acquired using the UGV.

Figure 5-7 4" x 4" and 3” x 3” water filled defects observed in the data acquired using the UGV.
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These images show the waveforms collected during testing. Since the waveforms that
were collected were identical for each antenna, only the image that looked the clearest was
displayed. The clearer image generally came from the antenna that was closer to the defects.
Despite their appearance these images are not 2 dimensional scans. These images are 1
dimensional scans taken in the direction of travel. To get the width of the defects, the test would
have to be conducted again so that the scans were perpendicular to the previous scans.

5.3.3 Conclusions from Experiment
From this experiment it can be observed that the 2 antenna setup can provide adequate
defect detection. Defect sizes as small as 2 inch by 2 inch can be detected with this setup. It is
important to point out that when employing a two antenna system, one of the antennas will
generally produce a clearer waveform. This is generally due to the position of the defect with
respect to the antennas.

It was also observed that using 2 antennas can decrease the overall resolution of the GPR
scanning. This is because the SIR-20 GPR acquisition system has a maximum number of
samples per scan of 1024. Since the UGV uses two antennas, the number of samples for each
antenna must be cut in half. This means that each antenna is only taking 512 samples per scan
instead of 1024. While this did not affect the quality of the GPR data in this particular test, it
may allow for very small defects to go undetected while performing analyses in the field.

5.4 IRT Defect Analysis
The IRT analysis conducted by the UGV was primarily used to detect air filled defects
between a wearing surface and an FRP deck.

5.4.1 Experimental Setup
The setup for the IRT testing was very similar to the setup for testing the GPR defect
analysis. This test used the simulated defects described in section 3.2.1. Instead of water
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pouches, the notches were left empty to simulate air filled debonds. Defects of plan sizes 2
inches x 2 inches, 3 inches x 3 inches, and 4 inches x 4 inches were used. The wearing surface
with the simulated defect samples were placed on an FRP deck for testing.

5.4.2 Experimental Results
During the IRT testing, images were obtained and examined to determine the quality of
the IRT analysis. Images acquired using the optional cooling fans were not as definitive as
some of the images that were acquired without the optional cooling. Images could be acquired
with heating times as little as 10 seconds; however. Figures 5-8, 5-9, and 5-10 show a few
sample images of the FRP deck that were obtained with 15 seconds of heating and both cooling
fans active. This means that there is 30 seconds of total cooling (15 seconds for each cooling
fan).

Figure 5-8 3" x 3" air filled defect observed after heating and cooling.
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Figure 5-9 4" x 4" air filled defect observed after heating and cooling.

Figure 5-10 4" x 4" (top, center) and 2" inch by 2" (bottom, center) air filled defects observed
after heating and cooling.

While the defects in the images are visible, it is very hard to say with certainty that a
defect actually exists in each image. It would take an experienced eye to find the defects in
images such as these during testing in the field on actual FRP decks. In these cases the
temperature differences observed between the defective area and the surrounding defect-free
areas are below what is considered acceptable in the field. The highest temperature difference,
which is observed in Figure 5-10, is roughly 0.95 degrees Celsius. This is much lower than the
typical 3-4ºC that is typically needed to confirm a defect in actual field testing.
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The images that were acquired without the optional cooling provided much better results.
Because there was were no cooling fans speeding up the process, a longer waiting time between
heating and analysis was needed. Heating times of 15, 20 seconds were explored, with waiting
times between heating and analysis of 30 and 40 seconds, respectively. Figure 5-11 shows some
sample images obtained with 20 seconds of heating with 40 seconds of waiting. In the image on
the left, a 4” x 4” air filled defect is clearly visible. An average temperature difference of 2.9ºC
between the defective area and the defect-free area is observed. In the image on the right, a 3” x
3” air filled defect can be seen but the boundary is less defined. An average temperature
difference of 3ºC between the defective area and the defect-free area is observed. Also visible in
both images is the gap between the wearing surface slabs. In essence when the wearing surface
slabs are placed on the FRP deck they create an air filled defect at the meeting of the slabs. Since
this is also an artificial air filled defect it shows up as a hotspot in the images.

Figure 5-11 IR images taken by UGV 20 second intervals of heating and no cooling.

The images generated without cooling are much easier to interpret and the observed
temperature differences are much higher. Another positive aspect of acquiring the images
without the cooling is that a problem with the heating was found and could be addressed. The
problem is visible in the images displayed in Figure 4-12 but is easier to see in Figure 4-13.
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Figure 5-12 IR image of 4" x 4" air filled defect with heating anomaly present.

The defect in the image is clearly visible. The circled area in the image; however, is not a
defect. The hot spot on the left hand side of the image could be interpreted as a defect, but this
would be incorrect. This anomaly shows up in every IR image that the UGV takes. This is an
artificial hotspot that is generated by the heating system. After trying to correct the problem, the
intensity of the anomaly has been lessened. Since we are cropping the image to a 240x240
image to give an analysis window of 1 foot by 1 foot, this anomaly does not show up as a defect
in any of the analyzed images.

5.4.3 Conclusions from Experiment
Even though the preliminary IR research showed that a cooling step could increase the
quality of the IR images at the cost of lower temperature differences, the optional cooling fans
actually made the data much harder to read. High quality images were obtained without the
cooling and defects could be observed by both human analysts and automated software routines.
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5.5 Combination of IRT and GPR
At this point in time, no tests have been conducted with both IRT and GPR analysis.
From the result of the previous tests, however, it is possible to speculate what a combined system
would be able to accomplish. The system would be able to detect both water and air filled
defects. By providing these capabilities, the UGV would be able to provide a much more
thorough picture of the subsurface condition of an FRP deck.
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Chapter 6

Conclusions and Future Work
6.1 Conclusions
The UGV described in this research is a major step in the automation of non-destructive
evaluation of FRP decks. Incorporating both IRT and GPR allow the UGV to gather valuable
data that can be used to determine both air and water filled defects.

Through experimentation with various heating sources, it was determined that passive
heating is not a feasible heating method to be used in conjunction with autonomous acquisition
of IRT data due to various problems, such as dependency on weather and possible uneven
heating. By using active heating, the UGV can avoid the problems that can occur with passive
heating. The active heating system that was designed allows the UGV to collect high quality
infrared images regardless of weather conditions. This alleviates one of the major disadvantages
of IRT. The autonomous motion of the UGV also alleviates the operator error that can be
introduced during testing, such as uneven heating of areas.

Also, even though the preliminary IR research showed that a cooling step could increase
the quality of the IR images at the cost of lower temperature differences, the optional cooling
fans on the UGV actually made the data much harder to interpret. High quality images were
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obtained without the cooling and defects could be observed by both human analysts and
automated software routines.

Automated defect detection using software algorithms for analyzing the IRT data was
also explored. Three different algorithms were implemented and tested. The grayscale
thresholding algorithm performed the worst, correctly identifying 83% of the simulated defects
but producing false positives in 21% of the images. The temperature thresholding algorithm
performed a little better, correctly identifying 85% of the defects with only 16% of the analyzed
images producing false positives. The Fuzzy C Means algorithm performed the best, though. It
correctly identified 42 out of 48, or 87.5% defects while only generating false positives in 8% of
the analyzed images. Real-time defect detection with any of aforementioned algorithms can be
performed. To achieve real-time detection with fuzzy clustering, however, some multi-threading
techniques may have to be employed.

The UGV that was built was able to successfully gather both IRT and GPR data.
Through the use of pipelining, the acquisition process is highly efficient. At this point in time,
no tests have been conducted with both IRT and GPR analysis. From the result of the previous
tests, however, it is possible to speculate what a combined system would be able to accomplish.
The system would be able to detect both water and air filled defects. By providing these
capabilities, the UGV would be able to provide a much more thorough picture of the subsurface
condition of an FRP deck.

It is important to realize that the UGV concept presented in this research is only a
preliminary design, not a final product. The UGV is a platform that combines IRT and GPR, but
at this point it is not a fully functional analysis system. While some data analysis is done on the
IRT data, no GPR automation has been done except collecting the data. Despite the lack of
automated analysis software for the GPR data, this UGV is a good first step in combining the
strengths of IRT and GPR for comprehensive testing of FRP bridge decks.
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6.2 Future Work
It is recommended that future research into the automation of subsurface defect analysis
be focused on automating the GPR analysis. Signal processing techniques can be employed to
analyze the GPR signals. Macros could also be written to automate the generation of 3D maps
from the GPR data. Also at the current time the IRT analysis can be controlled easily from a
laptop through the use of a Software Development Kit (SDK). This software library allows the
functionality of the IR camera to be controlled automatically through software. GSSI does not
provide any SDK for the GPR module. Since no SDK is provided by GSSI, a software library to
interface with the GPR module needs to be written to allow for complete automation of GPR
acquisition and analysis.

Research into improving the design of the active heating system should also be
considered. While the heating system provided reliable results, a better heating system could be
implemented to provide even better analysis.

Lastly, until the detection algorithms used with IRT data produce 100% accuracy, they
need to be improved further or new algorithms will have to be developed. Not detecting defects
in an FRP deck could be disastrous. If a structure is defective and the defect was not recognized
it could collapse and injure people. False positives, which are detecting defects where none
exist, are not as serious a problem but could cost money fixing areas that do not need to be fixed.
For these reasons, 100% accuracy is desired and the algorithms should be improved until that
accuracy is attained.
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Appendix
Since the UGV will operate autonomously during testing, most of the operator interaction
will involve the setup of the UGV and the retrieval of data from the UGV. This manual will
describe the basics of powering the UGV, setting up the GPR data acquisition, testing with the
UGV, and getting data from the UGV for post-processing.

Appendix A. Powering the UGV
1. Enable the motors and fans by turning on the switch located on the right side.

2. Turn on the power inverter, which is located on the underside of the upper deck. A red
LED will light up to show that the inverter is ready for use. This supplies the FLIR
A20M IR camera and the GSSI SIR-20 GPR unit with power.

3. Turn on the VEX robot controller. This is located beside the power inverter and is also
on the underside of the upper deck.
4. Power up the GPR laptop.
5. Power up the control laptop. Make sure that the serial cable from the VEX robot
controller and the firewire cable from the IR camera are connected to the laptop.
6. Lastly, turn on the VEX transmitter so that the robot can be moved. The transmitter is
used to move the UGV manually, but unless the transmitter is enabled, all functions of
the VEX robot controller are disabled. This means that even though the operator does not
plan on driving the UGV manually, the transmitter must remain on.
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Appendix B. Setting up the GPR data acquisition
First of all, make sure UGV is in starting position for test. Once the GPR data acquisition
is enabled, the data will be gathered anytime the UGV is moved. To get the UGV in the right
place, manually drive the UGV into position. The first turn that the UGV will make is a left
hand turn so be sure that the UGV is positioned on the far right edge of the deck to be surveyed
before operation.

To begin, start the program SIR-20 on the GPR laptop. Next set up the working
directories so the software knows where to put the data. Go to View->Customize. A window
like the one in Figure B-1 is displayed.

Figure B-0-1 Customizing Directories Window.

Now set the source and output directories. Once everything is to your liking then click
OK. Now to start a new project, go to File->New. This will open a window where you can
name a project. Enter a name and hit OK. The Project Information screen will appear next.
Make sure information on this page is correct and hit OK. This brings up the Data Collection
Model window. Select the survey wheel option and click the calibrate button. The calibration
distance should be 10 feet and the number of ticks per unit should be 625. Click Save.
The data collection parameters window, like the one shown in Figure B-2, should now be
displayed.
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Figure B-0-2 Data Collection Parameters Window.

Since we are using two antennas, select “Multi-chan” in the “Config Name” dropdown
box. In the samp/scan drop down box select 512. This value is the most we can use with 2
antenna channels. In the scans/sec text box enter 78, which again is limited by using 2 antennas.
Enter the dialectric constant for the FRP deck (for this research a value of 5 was used). Scans/in
should be 10 and in/mark should be 1. Once all this data is entered click apply.

Now you have to load a macro for the antennas so that the system can initialize them. The
macro file can be found at Desktop\Shortcut to Fixed SIR-20 Setups\1.5 GHz. You should hear
a series of beeps during which time the antennas will be initialized by the SIR-20 module.

The data being displayed may not be very good. To fix this Go to Process->Correct
Position. A window like the one in Figure B-3 will appear.
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Figure B-0-3 Position/Range Setup.

Uncheck the “auto position servo” check box. Now change the “Range (nS)” text box
from 12 to 4. Click apply and wait for the antenna to be reinitialized, during which time there
will be a series of beeps. Click the “Chan 2” tab at the top and do the same thing for channel 2.
The data in the graph will adjust itself each time you hit apply. When you are finished with this
step, the graph should look like the one in Figure B-4.
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Figure B-0-4 Position/Range Setup After Correction.

The next step is to set the gain on the antennas. To do this, go to Process->Range Gain.
The Range Gain Window, like the one in Figure B-5, should appear. Check the "Use Common
Channel Parameters" check box. The wave form for each channel should take up about 1/3 of
the graph at the difference between peak amplitudes. To change the amplitude of the waves, drag
the endpoints of the lower red line up or down and click apply to update the waveform. Make
sure that if you make any changes here that you click the apply button. Otherwise your changes
will be lost.
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Figure B-0-5 Range Gain Window.

The GPR system is now set up to acquire data. Click the "Run" button (the little green
arrow at top of screen) to begin gathering data. Once the “Run” button is clicked, the GPR data
will be collected whenever the UGV moves.

Appendix C. Operating the UGV during testing
1. On the control laptop, start up the IR_Auto_Acquisition GUI. Make sure that all other
programs, especially ThermaCAM Researcher or FLIR QuickView, are closed before
beginning the test.

2. Choose whether the UGV should operate in “Normal” mode or “GPR Only” mode. In
Normal mode, the UGV will collect IR images as well as GPR data. The wait time
between movements will be 30 seconds. This is done so that the heater can prepare the
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deck for IR imaging. In GPR mode, the UGV will simply move forward in 1 foot
increments. The wait time between movements will be significantly less (approximately
1 second).

3. Enter the deck dimensions. The dimensions will determine when the UGV will turn and
when the IR images will be taken. Make sure that you set these before the test begins,
otherwise the UGV will not perform correctly.

4. If operating in the normal mode, which means that IR and GPR data will be gathered,
now is the time to turn on the heating system. First, turn on the heating fan with the
additional remote control. If cooling is desired also use the remote to enable the cooling
fans. Now connect the propane tank to the hose. Hold the propane switch and use the
ignite switch to light the heater.

5. Lastly click the “Enable Auto Acquisition” button on the GUI. This will turn over
control of all functionality of the UGV to the GUI. It will move and gather data on its
own.

6. When the test is complete, a deckmap showing all the defects can be created by clicking
the “Generate Deckmap” button.

Appendix D. Getting IR data from the UGV after testing
Images captured from the IR camera during testing can be found in the CapturedImages
directory. The directory is located on the controlling laptop at “C:\Documents and
Settings\Robot\Desktop\IR_Auto_Acquisition\CapturedImages.” The filenames for the images
are numbered to make finding an image of a certain section easier. The images are named as
follows: Image_Row_X_Col_Y.jpg where X is the row number of the image and Y is the
column number. Figure D-1 shows an example of the layout of the images for a deck 10 feet
long and 5 feet wide.
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Figure D-1 Numbering format for Images captured by the UGV.

These images are grayscale images. Also in this directory are full color radiometric
JPEG files and temperature data files. There is one radiometric JPEG and one temperature file
for each grayscale IR image.

Images that were captured during testing were also processed. The analyzed images can
be found in the ProcessedImages directory. The directory is located on the controlling laptop at
“C:\Documents and Settings\Robot\Desktop\IR_Auto_Acquisition\ProcessedImages.” The
filenames for the images are numbered to make finding an image of a certain section easier. The
images are named as follows: OutputImage_Row_X_Col_Y.jpg where X is the row number of
the image and Y is the column number. Each grayscale output image corresponds to one
grayscale captured image. If a deckmap was generated during testing then the output file will
also appear in this directory named “Deckmap.jpg.”

The GUI program does not check for pre-existing files before generating new ones during
testing. As a result if the files are not moved they will be overwritten and previous test data will
be lost. To avoid lose of data, after finding all the IR data files, the operator must move them to
a new directory before any further testing. It is suggested that a new folder be created in the
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“CapturedImages” and “ProcessedImages” directories. The files can then be copied into these
new directories.

Appendix E. Getting GPR data from the UGV after testing
To begin creation of a 3D map of the FPR data start the program RADAN5.0 on the GPR
laptop. Open the project by going to File->Open and selecting the project that was created
during testing. This will appear in whatever directory was designated as output when you set up
the GPR data acquisition. The first step that needs to be done is to correct the position on the
GPR data. This is done so that all measurements start at the same depth. To do this, go to
Process->Correct Position. A window like the one in Figure E-1 will be shown.

Figure E-1 Position Correction Window.
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Use the “Delta Pos(nS)” to reposition the data. You should change the position such that
the first rise on the waveform begins at far left side of the graph. Next, click on the channel 2 tab
at the top of the page and do the same thing. Click “Apply.” After clicking “Apply,” the data
will be shifted so that the starting depth corresponds with the new depth. Since we changed the
starting depth we now have to change the label for the starting depth. To change these settings,
go to Edit->File Header. This will bring up the Edit File Header window, which is shown in
Figure E-2.

Figure E-2 Edit File Header Window.

Change the value in the “Position (nS)” text box to 0. Use the "Channel" button to switch
to the second channel. Change the value in the “Position (nS)” text box to 0. Click save. The
file settings are now updated.

The next step is to split the GPR data into 2 separate files, one for each antenna. Go to
“File->Save As” and in the lower left check the split channels check box. This will save the data
into two separate files. The base filename remains unchanged but two files will be generated in
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the same directory that will end in an "A" (meaning data from the antenna in channel one) or a B
(meaning data from the antenna in channel two).

Now we have to segment each antenna file into strips. Close the current file and open the
file ending in "A." At the beginning of the data you will see an area where all the energy is
reflected. This is the aluminum tape that was placed to denote the beginning of data. From this
point to the next section aluminum tape is the data from the first strip of deck that was surveyed.
To extract this data, we need to select a data block. First, right click on the scale on the left side
of the data. In the pop-up menu, change the horizontal scale to scans. Now go to Edit->Select.
This will bring up the Edit Block window shown in Figure E-3.

Figure E-3 Edit Block Window.

Change the starting point to the scan number of the first section of aluminum tape. Find
the next piece of aluminum tape and use that scan value for the End Scan value. Click OK. Go
to Edit->Save. This will open a save dialog box to save the block of data as a new file. Save the
newly segmented data file as something meaningful because you will be using it when you form
the 3D file. The next section of data should not be used. This is because that between the second
and third sections of aluminum tape is data taken while the UGV is turning. This data is not
considered part of the deck that is being surveyed. The section of data after the turning data is
the data collected from the second strip of deck and should be saved just as the first section was.
The 4th section should then be discarded because this is again turning data. Continue segmenting
the data in this way until you have pulled out each strip of the deck. Once this is done, the same
process must be completed for the data from the other second antenna, which is stored in the file
ending with a “B.”
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After all the data is segmented, close all the individual files. Go to File->New to begin
the 3D project. Make sure that the RADBridge Project option in the lower right is checked.
Click save. Check the information in the project information window and click OK.

The next window that pops up, which is shown in Figure E-4 allows you to add files to
the project.

Figure E-4 Adding Files to the Project.

The files that will be added are the segmented files that were just created. Each
represents one strip of the deck. The files must be added in the order of the scan (from right to
left). This means that since we are using two antennas we would have to add the first scan from
the antenna on the right first, then the first scan from the left antenna. Next would be the second
file from the left antenna, since we are turning the UGV which reorients the antennas. After all
the files have been added in the correct order click done.
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Next you have to attach a macro to each file that was added in the previous step. Since
the macro is not used for anything just create a file called "dummy.cmf" and attach it to each file.
When this is finished, click Done.

After assigning the macros, a window will pop up so the output parameters for the 3D file
can be set. Figure E-5 shows the 3D file parameters window.

Figure E-5 3D File Parameters window.

Make sure to specify a filename for the 3D output file, and then enter the dimensions of
the deck that was surveyed. The last settings are to specify the starting points in each file. To do
this click on the Files 1-8 tab, which displays a list of files in the project. Figure E-6 shows this
window.
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Figure E-6 File listing for the 3D File.

The button labelled "Click" shows the data file so you can click the starting position.
Remember that since the UGV collects data in one strip then turns around to get the next strip,
every other 2 files, meaning the 3rd and 4th files as well as the 7th and 8th, must be reversed by
checking the “rev” checkboxes. The starting point can then be chosen in the same way but the
user must select it from the end of the file, not the beginning. When all the files have been
assigned a starting point, click OK. The files will then be stitched together. Use the 3D Mode
button to look at the 3D model that was generated. Use the X, Y, or Z-Slice to look through the
model.
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